Chapter – IV
DESCRIPTION OF TOOLS
Chapter IV
Description of tools

The present chapter is the heart of the whole research thesis. So far the focus has been on the history, scope, need and listing of elements, the introduction to different variables under study, the review of related literature, objectives and hypotheses of multimedia but now we come to actual multimedia cocktailing of these elements that is combining all the elements of multimedia together and delivering them in one go. It means the focus will be on the description of development of achievement test, Opinionnaire, Multimedia Learning Package (MMLP) and Homepage. The present chapter deals with the description of tools.
For the present investigation, the following tools were used.

1. Achievement Test
2. Opinionnaire for teacher-educators
3. Multimedia Learning Package (developed by the investigator)
4. Homepage

4.1 ACHIEVEMENT TEST

‘Achievement Testing’ refers to the assessment of the outcomes of formal instruction in cognitive domain (Dwyer, 1982). It can also be thought of as a sample of indicator of a student’s knowledge taken at a particular point of time or achievement test may mean a sample of behaviour that provides opportunity for comparison with performance standard, as in criterion referenced testing it aids both the teacher and the students in assessing learning readiness, monitoring learning outcomes (Gronlund, 1977).

The researcher made a thorough survey of Achievement Test in the current available material for B.Ed. Class but could not locate an appropriate Standardized Achievement Test. Therefore, it was decided to develop an Achievement Test in Educational Psychology to evaluate the pre-service teacher’s knowledge, comprehension and application on the topics selected for treatment. A study of research and non-research literature motivated and helped the researcher to reflect on
the use of multimedia. The professional experience and expert opinion helped to
develop the Achievement Test.

Achievement Tests were prepared for all the five MMLPs consisting of 260 multiple
choice questions in total and after try out the final draft had 220 questions. 
Achievement tests covered all the important aspects of the lessons taught in the class
by the educators to the control group and experimental group both. The pre-service
teachers of experimental group had to mark the correct option on the computer and
on the basis of their answers the marks were automatically allotted by the computer
online. Whereas traditional group pre-service teachers were given printed
achievement test and answer sheets. The following steps were followed for
developing the tests:

(a) Planning the Test
Planning stage of the test tries to answer what content area is to be covered by the
test? What type of items are to be included in the test and what are the objectives that
are going to be tested?
The planning stage of a test should include the nature of the test items and the
statement of conditions under which it will be administered. The Achievement Test
was planned with the objective of measuring Achievement in Educational
Psychology of pre-service teachers (B.Ed. students) on selected topics. For the
planning of Achievement Test following points were taken into account:
(a) Determining the purpose of test;
(b) Identification and defining the intended learning outcomes;
(c) Preparing the test specifications; and
(d) Constructing relevant test items;
Steps of preparing Achievement Test:
1. Instructional objectives
2. Design
3. Blueprint
Objectives of the Test
For the purpose of constructing Achievement Test, objectives were defined in behavioural terms from selected units of Educational Psychology syllabus of B.Ed. class prescribed by various universities. Since the major concern here was to test the academic achievement, accordingly, it was decided to test the three major areas of cognitive domain, i.e., knowledge, understanding and application. After determining objectives, the learning outcomes were stated as observable terminal performance. In order to make sure that achievement Test measures a desired behaviour, test specifications were developed covering the objectives and subject-matter selected to be taught during the experiment.

Content of the Test
The test covered the content of the following five units:
1. Growth and Development
2. Learning
3. Motivation
4. Personality
5. Basic Statistics
To decide the weightage to be given to different content area, objectives and different forms of questions, expert opinions of the Educational Psychology educators were taken into considerations.

Preparation of the Test Items
260 objective type items with wide range of difficulty were constructed from five units of Educational Psychology syllabus prescribed by various universities for class B.Ed. Items were prepared in conformity with the Blue-print. While constructing items, it was ensured that no objective remained untested and language of the test items was understandable and unambiguous and the instructions were clear. The test items were arranged in the order of difficulty. The test items were arranged properly and assembled into the test. The preliminary draft in Achievement Test was given to experts in education, which included experts in measurement and evaluation and
experienced Educational Psychology educators. They were requested to give their opinion about the language and appropriateness of the items. Only those items were selected which were having 80% unanimity. Items that were having difficult language were modified to simple language. Finally, 220 items constituted the Achievement Test.

**Preparation of Directions to Test Items**

Appropriate directions to test items were prepared. The directions were clear and concise so that the pre-service teachers could understand them easily. As test was divided into sections, clear instructions were given in the beginning of each section. For objective questions, the control group pre-service teachers were instructed to write the correct response in the given answer sheet and pre-service teachers of experimental group were given instructions on the computer.

**Preparations of Directions for Administration**

A clear and detailed direction as to how the test is to be administered was provided.

**Preparation of Directions for Scoring**

To facilitate the objectivity in scoring, scoring keys were prepared. Scoring keys were prepared separately for 5 topics of Educational Psychology.

**First Try-Out**

The test was administered to 50 pre-service teachers of B.Ed.; Discriminating Power (D.P.) was computed for each item after forming top 27 per cent and bottom 27 per cent group from the total subjects as suggested by Kelley (1939). The blue-print of the first draft of Achievement Test and distribution of discriminating powers (D.P.) was as seen in Table 4.1 and 4.2. (Appendix F)

Q1 = Knowledge
Q2 = Comprehension
Q3 = Application
Table 4.1
Blue Print of First Draft of Achievement Test

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Cognitive Level of Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Q1</td>
</tr>
<tr>
<td>Growth and Development</td>
<td>11</td>
</tr>
<tr>
<td>Learning</td>
<td>12</td>
</tr>
<tr>
<td>Motivation</td>
<td>10</td>
</tr>
<tr>
<td>Personality</td>
<td>12</td>
</tr>
<tr>
<td>Basic Statistics</td>
<td>21</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td>66</td>
</tr>
</tbody>
</table>

Distribution of discriminating powers of items was calculated by formula

\[
D.P. = \frac{R_U - R_L}{0.5N}
\]

- \(R_U\) = No. of correct responses in upper group
- \(R_L\) = No. of correct responses in lower group
- \(N\) = Total no. of correct responses

Table 4.2
Distribution of Discriminating Powers (D.P.) of items of First Draft of Achievement Test

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>128</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>92</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>16</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt;0.19</td>
<td>24</td>
<td>Very Poor</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>260</strong></td>
<td></td>
</tr>
</tbody>
</table>

Second Try-Out
The revised version of the achievement test was administered on another group of 50 pre-service teachers of B.Ed. Again Discriminating Power of 220 items was computed. The distribution of discriminating powers can be seen in Table 4.3.

### Table 4.3

**Distribution of Discriminating Powers (D.P.) of items of Final Draft of Achievement Test**

<table>
<thead>
<tr>
<th>Discriminating Powers</th>
<th>Frequency</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.40 and above</td>
<td>128</td>
<td>Very Good Items</td>
</tr>
<tr>
<td>Between 0.30 and 0.39</td>
<td>92</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>Between 0.20 and 0.29</td>
<td>-</td>
<td>Needs Improvement</td>
</tr>
<tr>
<td>&lt;0.19</td>
<td>-</td>
<td>Very Poor</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>220</strong></td>
<td></td>
</tr>
</tbody>
</table>

In the light of the results as seen in Tables 4.2 and 4.3, out of 260 items, 40 items below the discriminating power of 0.30 were dropped and 220 items were retained. These items were improved with respect of languages and description. This led to the preparation of final draft of the achievement test. This draft of achievement test comprised of 220 items. The table of specifications of blue-print for achievement test is presented in the Table 4.4 and the numbers of retained items are shown in Table 4.5.

### Table 4.4

**Blue Print of Final Draft of Achievement Test**

<table>
<thead>
<tr>
<th>Chapters</th>
<th>Cognitive Level of Objectives</th>
<th>Q1</th>
<th>Q2</th>
<th>Q3</th>
<th>Total Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Growth and Development</td>
<td></td>
<td>07</td>
<td>19</td>
<td>14</td>
<td>40</td>
</tr>
<tr>
<td>2. Learning</td>
<td></td>
<td>08</td>
<td>22</td>
<td>20</td>
<td>50</td>
</tr>
<tr>
<td>3. Motivation</td>
<td></td>
<td>06</td>
<td>12</td>
<td>12</td>
<td>30</td>
</tr>
<tr>
<td>4. Personality</td>
<td></td>
<td>06</td>
<td>32</td>
<td>12</td>
<td>50</td>
</tr>
<tr>
<td>5. Basic Statistics</td>
<td></td>
<td>18</td>
<td>15</td>
<td>17</td>
<td>50</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td></td>
<td><strong>45</strong></td>
<td><strong>100</strong></td>
<td><strong>75</strong></td>
<td><strong>220</strong></td>
</tr>
</tbody>
</table>
Q1 = Knowledge  
Q2 = Comprehension  
Q3 = Application

Table 4.5
Number of items retained in the Final Draft of Achievement Test at different cognitive levels of objectives

<table>
<thead>
<tr>
<th>Cognitive levels of objectives</th>
<th>Serial Number of items retained</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding Level</td>
<td>1,2,3,5,6,7,8,13,14,15,16,17,18,21,26,28,29,32,34,42,46,49,50,53,54,55,56,62,63,64,66,67,68,69,72,73,74,78,79,87,90,91,92,99,100,101,102,105,107,110,111,116,119,122,123,124,125,126,130,131,132,133,134,135,138,139,140,141,142,144,150,152,153,154,155,156,157,158,160,162,164,169,170,171,179,183,185,190,191,192,194,195,197,198,202,208,209,216,218</td>
<td>100</td>
</tr>
<tr>
<td>Application Level</td>
<td>4,10,11,12,19,20,22,23,25,27,35,36,37,39,45,48,51,52,57,59,60,61,70,71,75,77,80,81,82,83,84,85,88,93,94,95,97,98,103,104,106,108,109,111,112,128,129,130,137,143,146,147,151,159,161,163,165,166,167,173,174,175,176,178,184,186,187,188,189,199,200,201,203,204,205</td>
<td>75</td>
</tr>
<tr>
<td>Total</td>
<td></td>
<td>220</td>
</tr>
</tbody>
</table>

Standardization of Achievement Test

220 items constituted the final form of the Achievement Test. The Achievement Test was further standardized by experimental validation of the test that included establishing reliability and validity.
Reliability of the Test

Reliability is one of the most important pre-requisite of a measuring tool. It is the degree of consistency between two measures of the same test. The reliability of a test refers to the extent to which a test measures consistently from one administration of the test to another. According to Fraenkel & Wallen (1993) reliability refers to the consistency of the scores obtained as how consistent they are for each individual from one set of items to another. The reliability of the test was measured by split-half method. The co-efficient of the Reliability of the test was measured by split-half method of the five test independently presented in the table 4.6.

Table 4.6

<table>
<thead>
<tr>
<th>Topic</th>
<th>Reliability Coefficient</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Growth and Development</td>
<td>.84</td>
</tr>
<tr>
<td>2. Learning</td>
<td>.86</td>
</tr>
<tr>
<td>3. Motivation</td>
<td>.85</td>
</tr>
<tr>
<td>4. Personality</td>
<td>.83</td>
</tr>
<tr>
<td>5. Basic Statistics</td>
<td>.88</td>
</tr>
</tbody>
</table>

The co-efficient of the Reliability for the whole test, as found by split half method, was 0.85 which indicates that the test is highly reliable. According to Fraenkel and Wallen (1993), reliability coefficients of .70 or higher are acceptable for research purposes. The reliability co-efficient of the present test was 0.85. Therefore, the achievement test may be considered fairly reliable.

Validity of the Achievement Test

Validity is a concern for the relationship between, the purpose set to achieve, on the one hand, and the efforts made, the means employed and what these efforts and means actually achieve, on the other. The Validity of the Achievement Test constructed for the study was taken for granted because this is in accordance with Guilford (1971) who said, “There are some measures whose validity is taken for granted, for example, Achievement Test scores.”
Content Validity

Regarding the method of establishing the validity of the test, Mouly (1970) stated, 'At the most elementary level, it is necessary for all the test' to have content validity, i.e., each question must be related to the topic under investigation, there must be an adequate coverage of the overall topic, the question must be clear, unambiguous, etc. The most adequate approach to validation consists of checking the agreement between the responses elicited by the question against the criterion.

The present achievement test was validated against the criterion of content validity. Content validity is the most important criterion for the usefulness of the test, especially of an achievement test. It is a measure of the match between the content of the test and the content of "teaching" that preceded it. The measure is represented subjectively by the researcher after a careful process of inspections comparing the content of the test with the objective of the course of instruction. Thorndike (1975) maintained that problem of content validity is parallel to the problem of preparing a Blue print for a test and then building a test to match the Blue-print. So, the Achievement test was found to possess Content Validity as there was correspondence between the table of specifications and test items.

Construct Validity

The construct validity refers to an analysis of “effective expression” of items in the test. Selection of ideas to be presented, organization of ideas for presentation, paragraphing, writing effective sentences, effective use of words, form and style to message are the main components for analysis of effective expression (Thorndike and Hagen; 1955).

In the present study the investigator organized the ideas of the selected topic in a logical order and gave adequate representation to all the concepts. The style and language of sentences were simple. Effective use of words was made by selecting the precise meaning and variety. Narration in proper style with simple words constituted easily readable and comprehensible sentences. Thus the achievement test prepared by the investigator fulfilled the requirements for effective expression. Hence the test has good construct validity.
Final Form of the Test

The final form of the Educational Psychology Achievement Test contained 220 items, along with a scoring key (Appendix D).

4.2 OPINIONNAIRE FOR TEACHER EDUCATORS

Opinionnaire - Opinionnaire refers to a formal statement or estimation of professional advice. In the context of the present study, the Opinionnaire aids the researcher in assessing the effectiveness of Multimedia Learning Package in terms of content, presentation and its utility for Teacher Educators. It also helps in studying the role of MMLPs in creating the learning readiness, monitoring learning process, diagnosing learning difficulties. It also helps in evaluating the acceptability of MMLPs by Teacher Educators to further judge the effectiveness of the Multimedia Learning Package as compared to traditional method of teaching. A thorough literature survey of opinionnaire available for Teacher Educator was made but the researcher was not able to locate any such appropriate opinionnaire based on MMLP catering to the topics selected for the study. Hence it was decided to develop an opinionnaire for Teacher Educators to seek their opinion on the MMLPs.

An opinionnaire was developed to elicit the opinions of the teacher educators to determine the effectiveness and the acceptability of the Multimedia in teaching Educational Psychology. An Opinionnaire consists of items with three alternative responses at the 3 point rating scale (Agree, Disagree, and Undecided) i.e. a score of 1, 0 and 0 were assigned to alternative responses respectively. At the end of the opinionnaire, a column for remarks was made. The opinionnaire was submitted to the four experts along with the design of the Multimedia Learning Package for establishing the validity. The format was accepted by the experts. The opinion of 10 Teacher Educators teaching at B.Ed. level was obtained.

Development and Description of Opinionnaire

The Educator is considered the pivot upon which lies the success or failure of an educational programme. The opinionnaire was meant to obtain the information
about the effectiveness of the Multimedia Learning Package for B.Ed. level for teaching Educational Psychology.

After discussions with educationists, supervisor and Educational Technology specialist, and the following criteria were delineated for multimedia package evaluation:

The evaluator criteria of Multimedia Package

i) Content characteristics

ii) Instructional characteristics

iii) Technical characteristics

iv) Management characteristics

1) The evaluatory criteria of Multimedia Package

i) Content Characteristics: The presentation of content was viewed from the aspects;

   a) The appropriateness of content,
   b) Extensive uses of examples and illustrations to clarify content,
   c) Appropriate language, etc.

ii) Instructional Characteristics: The methods, strategies, etc. focussed upon delivering content were considered as follows;

   a) Logical presentation of the content,
   b) Motivation,
   c) Ability levels of students,
   d) Self-pacing, etc.

iii) Technical Characteristics: Some techniques used in enhancing the learning competencies of students as;

   a) Screen display of content,
   b) Graphics/animation,
   c) Music,
   d) Video, etc

iv) Management Characteristics: Dealt with management characteristics such as; ease in use of MMLP, test items, etc.
Figure 4.1 The basic criteria for a good Multimedia Package

The Opinionnaire comprised of two parts

Part A - aimed at eliciting information from the Educator with regard to Name, Sex, Age, Educational qualification, Professional Qualification, Designation, Name of the college, Teaching Experience, Subject taught, Classes taken, Teaching Background and Methodology used by them in the class room.

Part B - was meant for obtaining information regarding the MMLPs Multimedia Learning Package used and their opinions on the various aspects, relevance and effectiveness of the Multimedia Learning Package for Teacher Educator.

The following steps were taken for developing the opinionnaire:

Planning the test

Planning stage of framing opinionnaire focuses on the areas to be covered by the opinionnaire which may also include the listing of items and the objectives for the opinionnaire. This stage was very important because it threw light on the core areas of MMLP. The opinionnaire under reference was planned for the Teacher Educator teaching Educational Psychology with the objective of seeking their opinion on the
statements on Multimedia Learning Package of B.Ed. The planning of opinionnaire aims at:

- Determining the purpose of opinionnaire
- Identifying and defining the intended teacher educator's opinions.
- Preparing the opinionnaire specifications and
- Constructing relevant items for the opinionnaire

For constructing Opinionnaire, the objectives were outlined from the MMLPs of selected topics of Educational Psychology of B.Ed. The major concern was to seek the opinion of the Teacher Educators.

**Objective of the Opinionnaire**

To find out the effectiveness of MMLP for Teachers Educators, the opinionnaire covered the following areas of the MMLP.

- Content
- Presentation
- Benefits to students (pre-service teachers)
- Benefits to teacher educators

**PREPARATION OF OPINIONNAIRE ITEMS AND FIRST TRY OUT**

**Constructions of statements** - The following steps were followed in constructing items for the opinionnaire:

Development of statements – a set of questions that on the face of it seemed to measure the relevant concepts were selected to reflect orientation to the Multimedia Package evaluation. A total of sixty items encompassing the four criteria were submitted to educationists and experts of educational technology. They were requested to judge the items in terms of

i) Whether any important aspects of multimedia package evaluation were left uncovered.

ii) Whether the items were relevant and suitable for realising the objectives of the study.

iii) Whether any of the items could be improved by rewriting.
iv) Whether some new items needed to be added.

60 statements were framed to elicit the views of teacher educators on a three-point rating scale. The preliminary draft of opinionnaire was framed and given to 5 teacher educators of Educational Psychology after showing the MMLPs. They were requested to give their opinion about the language and appropriateness of items, based on the MMLP. Only those items were selected which were having 80% unanimity. 44 statements constituted the Opinionnaire after first try-out.

As the table 4.6 has shown that if discrimination index is either equal to or greater than 0.30 (> 0.30) than the item discriminate otherwise not. So, the investigator selected the statements discrimination index of 0.30 or above.

Table 4.7

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Discrimination Index</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80%- 100%</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

Table 4.8

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Below 30%</td>
<td>3, 5, 9, 11, 20,23,25,30, 35,37,42,45, 48, 51, 53, 58.</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2.</td>
<td>30% - 60%</td>
<td>1,4,6,7,8,10,12,13,14,17,19,21,24, 26,27,31,32,33,34,36,38,39, 40,41, 43,44, 46,52,56,59</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3.</td>
<td>60% - 80%</td>
<td>2,16,18,22,28,47,49,50,55,60</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4.</td>
<td>80%- 100%</td>
<td>15,29,54,57</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>
SECOND TRY-OUT

The opinionnaire was tested and tried out with a group of another 10 teacher educators. Out of 44 statements another 4 were rated below the acceptability level, while 40 statements were selected for the final draft. The blue-print of the draft of opinionnaire and distribution of discriminating powers is given in the table.

Table 4.9

Discrimination Index after Second Try Out

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Discrimination Index</th>
<th>Item No.</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Below 30%</td>
<td>3, 5, 7, 9, 11, 20, 23, 25, 30, 33, 35, 37, 41, 42, 45, 48, 51, 53, 56, 58</td>
<td>Poor items to be rejected</td>
</tr>
<tr>
<td>2</td>
<td>30% - 60%</td>
<td>1, 4, 6, 8, 10, 12, 13, 14, 17, 19, 21, 24, 26, 27, 31, 32, 34, 36, 38, 39, 40, 43, 44, 46, 52, 59</td>
<td>Reasonably Good</td>
</tr>
<tr>
<td>3</td>
<td>60% - 80%</td>
<td>2, 16, 18, 22, 28, 47, 49, 50, 55, 60</td>
<td>Good Discriminator</td>
</tr>
<tr>
<td>4</td>
<td>80%- 100%</td>
<td>15, 29, 54, 57</td>
<td>Best Discriminator</td>
</tr>
</tbody>
</table>

Final form of Opinionnaire

i) After going through 2 try outs the final form of opinionnaire has 40 statements (Appendix E).

Table 4.10

Distribution of Final Items in opinionnaire

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Category</th>
<th>No. of Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Content Characteristics</td>
<td>10 Items</td>
</tr>
<tr>
<td>2</td>
<td>Instructional Characteristics</td>
<td>17 Items</td>
</tr>
<tr>
<td>3</td>
<td>Technical Characteristics</td>
<td>5 Items</td>
</tr>
<tr>
<td>4</td>
<td>Management Characteristics</td>
<td>8 Items</td>
</tr>
</tbody>
</table>
Open ended questions were included at the end of opinionnaire to enable the Multimedia Package evaluators to identify overall strengths and weaknesses of the Multimedia Package.

On the basis of 2 tryouts the Investigator categories each item according to their discrimination index as shown in the table 4.9.

**Reliability** - The reliability is the property of an item which reflects its consistency. If the same opinionnaire is given second time, similar results must be achieved. The present form of opinionnaire stood firm on the two trials. The reliability of the opinionnaire was measured by split-half method. The co-efficient of the reliability, as found by split half method, was 0.91 which indicates that the opinionnaire is highly reliable.

**Validity** - Validity of a test or opinionnaire is the extent to which it measures what is attempted to be measured. This implies that the opinionnaire here should conform to the objectives of the testing. It was found that the statements of the opinionnaire were framed with the objective to seek the opinion of the Educational Psychology educators on MMLPs. The opinionnaire was given to 4 Educational Psychology experts and they made few suggestions which were incorporated, but it was widely accepted by the experts and the response from teacher educators further established the validity of the opinionnaire. The present opinionnaire is reliable, valid, covers all the elements catering to the objective, length of the opinionnaire is optimum, it is easy to administer, has scorability and above all its comprehensiveness takes care of all the aspects and nothing goes un-escaped.

After the final draft was accepted these opinionnaires were filled up by the teacher educators providing the required information in different columns. Teacher educators were required to provide answers to the questions where some information is sought by writing in the space provided for it. They had to tick the right column where their opinion was sought. They had to tick one of these columns (agree/ disagree/ undecided) as per their choice. The teacher educators were requested to make information as elaborate and descriptive as possible to enable to understand the
effectiveness of the Educational Psychology Multimedia Learning Package and for further planning new inputs and improvement of existing Multimedia Learning Package.
Their comments were sought on the issues like - the strong points and the weak points / problem areas of this Multimedia Learning Package, their suggestions for making this Multimedia Learning Package better in future.

4.3 DEVELOPMENT OF MULTIMEDIA LEARNING PACKAGE
This is the heart of the whole research thesis. It focuses on the actual multimedia cocktailing of elements (text, audio, video, animation, and graphics) that is combining all the elements of multimedia together and delivering them in one go. It also highlights the development of Multimedia Learning Package (MMLP) and its various stages. Since no syllabus based, MMLPs were available, so the investigator decided to develop the Multimedia Learning Package and computer online Achievement Test on her own. The development of MMLPs was a rigorous process and it had 3 major stages.

4.3.1 MULTIMEDIA LEARNING PACAKAGE DEVELOPMENT STAGES
Step- I. Development of Multimedia Learning Package
Development of Multimedia Package included the following three major stages.
1. Concept
2. Design
3. Production

Figure 4.2 Multimedia Learning Package Development Stages
I. Concept Phase (First Stage)

Every programme and project begins with a concept, so MMLP is no exception. An MMLP concept is the concise definition of the programme that can be designed and produced as per the specific requirement of the target group. A clear concept is important because it lays foundation for an effective Multimedia Learning Package. Hence changing the concept during any subsequent stages can turn disastrous. So the researcher needed to be very clear about the concept because any change at later stage could have altogether altered the direction and constitution of the Multimedia Learning Package.

![Diagram of Some Basic Questions](image)

Some basic questions asked at this stage were

1. What will it be about? (Syllabus e.g. Learning)
2. What should it be called? (Title of the MMLP e.g. Growth and Development)
3. Who will be the user? (Audience/student – Pre-Service Teachers)
4. What do we want to give the user? (knowledge, understanding and application)
5. What will interest the user? (elements – text, animation, graphics or audio to encourage exploration).
Significance of Plan Approach at Concept Stage

The concept phase was crucial because it had impact on both design and production and the overall shape of the proposed Multimedia Learning Package. So careful thought was given to the implications of the concept, for instance, including heavy layering or extra information was avoided, since it could lead to problems at the designing and production stage.

Design directly gets affected by any inclusion or exclusion of tests and graphics thereby affecting the production which may over extend itself as resourcing and configuration issues also arise because of any additional considerations at the concept stage. It is always recommended that a clear plan approach should be undertaken.

Aims and Objectives  
Length and Duration  
Selection of the Title  
Brief Content Outlines  
Content Levels as per Syllabus  
Description of Proposed Application  
Outline of Proposed Methodology  
Target Audience – Class or Level of Students  
Budget – Expenditure in Developing MMLPs

Figure 4.4 Plain approach at the Concept Stage

Thus a clear plan approach was undertaken by the researcher incorporating the following points at the Concept Stage:

- Aims and objectives of the MMLP
- MMLP length and duration
- Selection of the title
- Brief content outlines
- Writing of Instructional objectives
- Outline of proposed methodology was framed.
• Description of proposed application (format, media, etc.)
• Content levels (e.g. general, specific as per syllabus)
• Target audience (e.g. class or level of students)
• Budget (e.g. expenditure in developing MMLPs)

So it is the proper development and the understanding of the concept that stands behind every successful MMLP apart from skills and resources.

2. Design Phase (Second stage)

Design is a complex area in the development of Multimedia, however it is often recommended to keep the design simple and adhere to usability guidelines wherever possible. This means that design elements must be comprehensible and support the drive for user intuitiveness. Consistency is also essential for design. Any design features should adhere to usability standards. So an utmost care was taken in keeping the consistency at all steps.

Following points were taken care of while designing the Multimedia Learning Package:

List of actions addressed at the Design Stage:

• Designing a script
• Storyboard, the content and screen elements were short listed.
• Media type, format, standards were specified.
• Flowchart of components was constructed.
• Images, graphics, Animation items, Audio and Video to be included were decided.
• Consistency in layout (e.g. design, colour, etc.).
• Consistency in terminology was maintained (e.g. menus, commands).
• Consistent titling/headers were done.
• Font size was made readable.
• Content layout was kept sensitive to screen size/view area.
• All images had descriptive alternative text (e.g. ALT tags in web).
• Simple background colours were used to allow enough contrast for users with vision disability.
Video and audio clips had text equivalent.

Elements of a Good Script for a Multimedia Learning Package
Following points were being taken care of by the researcher while writing the script of MMLPs:
- An attractive start
- Clarity of concept
- Objective based content
- Known to unknown approach
- Interactive in nature
- Simple language
- No tricks
- Easily understandable technique
- No ambiguity
- Smooth transition
- Component of humour / fun
- Re-Enforcement
- Smooth Closure

Figure 4.5 Elements of a Good Script for a Multimedia
3. **Production Phase** (Third stage)

The production period is dependent on the concept and design processes; being harmonised through agreement in appropriate resourcing, scoping and development time. It was thus essential to plan out the issues of workflow, and that the researcher recognised the projected deliverables and outcomes in the production stage, in the light of objectives desired at concept stage. Mapping of milestones was done and activities were minutely monitored. Additionally, a post-production period was included in the overall development plan for quality assurance, testing, tweaking, and evaluation. So Production stage was the stage of implication.

The production phase, including post-production, had taken into consideration the following:

- Production of MMLPs including visual, audio, animation, graphics and video
- Mapping milestones
- Workflow, Progress reporting and Monitoring
- Testing with target audience
- Evaluation (production and post-production)
- Incorporation of modifications on the basis of feedback
- Review processes to see the effectiveness of the programme

4.3.2 STEPS OF DEVELOPMENT OF MULTIMEDIA LEARNING PACKAGE

The following list provides an overview of the various stages that were crossed in developing MMLP

I. Data Gathering
II. Navigation Method
III. Media Contents
IV. Interface Designing
V. Storyboard
VI. Authoring
VII. Data Delivery.
4.3.2.1 Data Gathering

Data Gathering was the first step and it included following phases-

- Information Collection
- Analysis and Filtering
- Organization
- Verification

Figure 4.7 Steps of data gathering
Stages – 1 Information Collection – At this stage the researcher collected all the information relevant to the MMLPs. The required content information was collected from the books as per the syllabus of class B.Ed. and it was further enriched from the web and library. After collecting it was analyzed, filtered and organized.

Stage-2 Information Analysis and Filtering - Filtering is a process of deciding which information is reliable and authentic and which is not. At stage two the researcher filtered the information and this helped in deciding the volume and depth of the information needed for the MMLPs. Not all the information gathered was found useful for the MMLPs. So the data needed to be edited, modified and even deleted altogether.

Stage-3 Data Organization- The filtered data was keyed into computer for further processing. A blue print of the MMLP got ready. At this stage the researcher got a fair idea about how the MMLP would be evolved in terms of the content. The information was organized in a logical and sequential manner. This stage was the backbone of the MMLP development.

Stage-4 Data Verification and Authentication - Once all the necessary information had been collected and organized, it was verified and authenticated as per the specifications of the syllabus and necessary corrections were made.

4.3.2.2 NAVIGATION METHOD

Linear structure approach was used for navigation. It is the simplest approach where the user moves through a sequential straight lined path, one part after another. Here the user had the option of moving one step upwards and backwards.

```
  Screen 1
    ▼
  Screen 2
    ▼
  Screen 3
    ▼
  Screen 4
```

Figure 4.8 Navigation Method- Linear
4.3.2.3 MEDIA CONTENTS

Once the contents and navigation structure had been organized, the attention was paid to multimedia elements required for development of MMLPs. These included elements of multimedia namely; audio, video, graphics, text and animation.

**Table 4.11**

**Multimedia Elements and Contents**

<table>
<thead>
<tr>
<th>Media Elements</th>
<th>Typical Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio</td>
<td>Background music, background voice.</td>
</tr>
<tr>
<td>Video</td>
<td>Videos of “Skinner Box”, “Maslow’s Hierarchy of Needs” and “Rorschach Test” as used in MMLPs – ‘Learning’, ‘Motivation’ and ‘Personality’ respectively.</td>
</tr>
<tr>
<td>Text</td>
<td>In all MMLPs content specific for title, main body and conclusions in all slides.</td>
</tr>
<tr>
<td>Graphics</td>
<td>Backgrounds, pictures, images. Widely used in all MMLPs.</td>
</tr>
<tr>
<td>Animations</td>
<td>Used for titling and highlighting effects as used in all MMLPs e.g. animated pictures in Motivation., animated picture of human being in growth and Development and animated pictures to show Watson’s experiment in Learning.</td>
</tr>
</tbody>
</table>

Multimedia Learning Package were developed using various elements of multimedia audio, video, test, graphics and animation.

![Elements of Multimedia Learning Package (MMLP)](image)

**Figure 4.9 Elements of Multimedia**
Text:

Text has played an important role in development of MMLPs. The extent to which texts have been used in MMLPs depended upon three major factors:

- The nature of the MMLP (Growth and development, Learning, Motivation, Personality, Basic Statistics)
- The subject/content (specific title and portion of the topic taken)
- The treatment of the subject/content (heavy graphics/ light graphics/ heavy text/light text)

Texts have been used in MMLPs for different purposes:

- Title texts
- Body texts
- Menu
- Miscellaneous texts

The design rules that governed multimedia texts largely depended upon the context in which particular text appeared. In general the title texts were bigger in size and were employed brighter colours than the body texts.

Designing text involved two basic aspects of information that were - Content and display.

- Content covered the matter that was being presented.
- Display covered how that matter was being presented.

The three parameters that controlled the display design of multimedia texts were:

- Fonts
- Font colours
- Backdrop (background)

It was noticed that while the fonts affected the profile of the displayed texts, colours and background affected the overall appeal of the same.

Graphics

Graphics play a pivotal role in multimedia applications. The maxim 'a picture is worth a thousand words;' is so factual that one cannot underestimate the impact of visuals over plain text or audio, in the context of multimedia. Graphics in multimedia
represent a collective terminology that includes all kinds of still pictures like images, photographs and art works used in MMLPs applications. It doesn't include any entities with dynamics and movements -like animation and videos. Graphics used in MMLP were characterized by certain attributes which made these MMLPs effective.

- Graphics were kept as simple and appealing.
- They fittingly captured the mood of the title.
- They were designed and selected suitably to fit the overall theme of the design.
- They were even used as background image or moving from one concept to other.
- They were developed in exact concurrence with other forms of media presented like texts videos so that all these elements fitted together as one seamless stream of information.

Types of graphics imagery used in MMLPs fall under any one of the following categories:

- Photographs (either scanned or digitally photographed)
- Clip arts (drawings drawn or taken from clip art files)
- Miscellaneous variety (all other types of images)

Graphics are important companions to information, when suitably presented. In present 5 MMLPs 20-30% of space was dedicated to graphics and the rest was filled by textual information. Pictures can hold the attention of the viewers longer because of its interactivity and wide variety. Pictures have been used by the researcher to cover the various aspects of the selected topics. For example for explaining word notes in Personality words like Archetypes and Rorschach test could be explained better with visuals.

**Audio**

Audio plays a vital role in the making of an MMLP. In all the 5 MMLPs audio has been widely used. It has been put in the form of natural sounds, music, dialogues and narrations. While developing these MMLPs audio recording was a serious business and it needed great effort and expertise.

The three major steps of audio input are:

- Sound recording
• Sound editing
• Sound delivery

Step One

**Sound Recording** - Sound recording was done taking all the precautions like when microphone based recording was done, a place was selected with least noise disturbances from outside. The microphone was connected to the mic-in jack of the sound card of the computer and the sound was recorded. After the recording got over the stop button was pressed and the sound file was saved on the computer using one of the media players.

Step Two

**Sound editing** - Sound editing demanded even more expertise than the sound recording. Effective sound editing demanded a great deal of creativity and timing. It was the stage where all the errors of sound recording were noticed and corrected. The noise reduction was done in order to enhance the audio quality / volume or dullness in some places.

Step Three

**Sound delivery:** Audio has been delivered using MP3 or Microsoft WAV formats. Audio has served several purposes.

- It offered a commentary that supplemented text
- Audio files being smaller to load than video and proved less fidgety than video plug-ins.

So sound has been an essential element of Multimedia Learning Packages. It was therefore, very important for the researcher to understand the nature of sound, its components and characteristics. By using commentary and powerful narration, combining the sound effects, music and dialogues, wonderful and fascinating pictures could be created.

Human voice especially the voice of children/teacher in the form of dialogues, narration, commentary or recitation has worked like magic and has made the Multimedia Learning Package interesting and fascinating. Similarly the background music and suggestive music (happy, sinister depending upon the nature of the package) has made it more effective. Atmospheric sound effects, sounds of wind,
birds or special noises etc. have been used to enrich and emphasize the impact and meaning. Thus sound has provided rich and enormous possibilities to enrich the teaching learning process.

Audio has been used in all the Multimedia Learning Package and it has added to the effectiveness of MMLPs.

**Video:**

Video has been delivered using media player. Video proved to be an effective supplement to text and images and provided enhanced experience. In the Multimedia Learning Package (Learning, Motivation, Personality) video clippings has been used to explain different topics.

**Animation:**

Animation is derived from the Latin word meaning “bring to life”. Rapidly changing the image on the screen to create the illusion of motion is called animation. In other words, modeled objects are brought to life in animation. Although animation is considered synonymous with motion, it covers all changes that have a visual effect. It thus includes the time varying position, shape, colour, transparency, structure and texture of an object. To animate something is, literally, to bring it to life. A computer based animation is an animation performed by a computer using graphical tools to provide visual effects.

Animation has been used by the researcher for:

- Showing concepts or states in transition
- Indicating dimensions
- Visualising 3D structures

Educationists have found that children love animation by nature. In the Multimedia Learning Package animation effect was added for explaining different concepts. It has also been used for achievement test. It was highly stimulating and brought in the feeling of participation in the learning package. The viewers were completely involved and remained active. It also helped in the retention of attention of the viewers.
4.3.2.4 INTERFACE DESIGNING

At this stage, backgrounds and buttons to link slides was infused.

Technical PowerPoint Vocabulary for Multimedia

Every instructor who wants to develop multimedia programme needs to familiarize with the vocabulary of Microsoft power point. Following are the few common terms used throughout while developing an MMLP (a PowerPoint presentation).

Slide: An individual screen in a slide show.

Presentation File: The file you save to disk that contains all the slides, speaker's notes, handouts, etc. that make up your presentation.

Object: Any element that appears on a PowerPoint slide, such as clip art, text, drawings, charts, sounds, and video clips. You can refer to a clip art object, a text object, a title object, a drawing object, etc.

Slide Show: A series of slides displayed in sequence. A slide show can be controlled manually or automatically.

Transition: A special effect used to introduce a slide during a slide show. For example, you can fade in from black, or dissolve from one slide to another.

Development of Multimedia Package using PowerPoint
The toolbars helped the investigator perform various tasks

The toolbars contain graphically illustrated buttons that you click to perform specific tasks in a program. PowerPoint 97 has four main toolbars, which can help you create your presentations quickly and easily.

The **Standard Toolbar** is located at the top of the PowerPoint window, below the menu bar. It has buttons for common tasks such as saving, printing, checking spelling, and inserting charts and tables.

The **Formatting Toolbar** is located just below the standard toolbar. Most of its buttons are for formatting text. Use these buttons to change the font type or size, make text bold or italic, indent text, and insert bullets.

The **Drawing Toolbar** is located at the bottom of the PowerPoint window. It has tools for drawing shapes, adding lines and curves, and inserting text boxes and WordArt. It also has buttons for manipulating and formatting the objects you draw.
The Common Tasks toolbar is initially a floating toolbar. That is, it isn't anchored to an edge of the PowerPoint window. Use this toolbar to create a new slide, change the layout of a slide, or apply a design.

The investigator moved the toolbars to new locations

All PowerPoint toolbars can be moved or docked to any side of the PowerPoint window. As well, docked toolbars, including the Standard Toolbar, the Formatting Toolbar, and the Drawing Toolbar, can be converted to floating toolbars.

A move handle on the left or top of the toolbar indicates that the toolbar is docked. A title bar indicates that the toolbar is floating.

Here's how to move one of the toolbars to a new location:

1. Clicking the move handle on a docked toolbar, or click the title bar on a floating toolbar.
2. Holding down the mouse button, drag the toolbar to the new location.
The investigator docked the toolbars to create more working area:
The investigator docked the Common Tasks toolbar to the top of the PowerPoint window. This will give you more working area on your PowerPoint window.
1. The investigator clicked the title bar on the Common Tasks toolbar.
2. Then dragged the toolbar upwards, until the toolbar outline snaps into place along the edge of the program window.
The handles that appeared on the toolbar confirmed that the toolbar had been successfully docked.

Adding and removing toolbars
PowerPoint has several other toolbars to help you accomplish your tasks.
The Picture Toolbar has several buttons that are useful when you work with images. There are buttons for Contrast, Brightness, and Cropping. This toolbar will automatically appear when you insert clip art or pictures.

The investigator reached an advanced user stage and wished to add some of these toolbars to the PowerPoint window. Here are the steps taken by the investigator to add the animation effects toolbar.
1. The investigator clicked the View menu, and then point to Toolbars.
2. In the submenu, clicked the check box next to animation effects. An animation effects toolbar appeared in the PowerPoint window.

The following steps helped the investigator to remove a toolbar. PowerPoint helped the investigator even remove toolbars which were not needed.

1. The investigator clicked the View menu, and then point to Toolbar.
2. In the submenu, clicked the check box next to animation effects to deselect it.

The check mark disappeared and the animation effects toolbar was removed from the PowerPoint window.

Making a Multimedia Learning Package

The investigator created a Title Slide for MMLP using the Blank Presentation option.

The investigator worked in Slide View.

1. The PowerPoint program was opened. The PowerPoint dialog box appeared.
2. In the PowerPoint dialog box, the investigator clicked the Blank Presentation option button. The New Slide dialog box appeared. It asked to choose an AutoLayout format.

3. Then the Title Slide layout was clicked. It was the first in the list. The name Title Slide appeared in the preview box.

4. After clicking OK. A Title Slide appears, ready for you to work with.

The PowerPoint dialog box appeared only when the investigator first launch the program. When the investigator already working in PowerPoint and want to create a new blank presentation, then the New button on the Standard Toolbar was clicked and these steps were followed:

1. The investigator clicked the File menu, and then clicked New.
2. In the New Presentation dialog box, clicked Blank Presentation, and then clicked OK.

Adding text to a slide

The Title Slide layout contains text boxes for a title and a subtitle. The investigator typed Text into these boxes.

1. Clicked in the Title text box. A thick gray border appeared around the text box indicating that it was selected.
2. Typed a title.

3. Clicked the Subtitle text box and typed a subtitle.

Following steps were taken for Adding another slide

1. The investigator clicked the New Slide button on the Common Tasks toolbar.

2. Then the AutoLayout dialog box appeared and from there a layout was chosen for the next slide.
While developing MMLPs, the investigator used a lot of text so choice of the right kind of font/its colour/size could make or mar a presentation.

Since a wide variety of fonts was available for experimenting, it was lots of fun to try out different fonts. Considering there were thousands of fonts out there, the investigator could end up making some pretty wacky choices for the MMLPs. Making an entire MMLP loaded with varied fonts might be fun for the creator, but it could end up being difficult - if not impossible - for the pre-service teachers, our audience to comprehend. For this reason, it was important to choose the fonts very carefully.

If a presentation contains a lot of text, it's good to use a font such as Times New Roman, which is known as a "serif" font. A "serif" is a small, decorative mark that finishes off the stroke of a letter. There are also other fonts called "sans-serif" - which means: without serif. "Sans" - as you may recall from French class - means "without." In general, it is easier to read a large amount of text when a serif font is used. Sans-serif fonts also tend to create a more casual, less-formal impression.

If you want to use different fonts within the same presentation, it's best to keep it down to only two or three. Using a smaller number of fonts will keep things orderly; too many different types may make it all a bit too chaotic. Like so many things in life, you'll just have to experiment before you know what works best.

When the investigator was trying to decide which fonts to use, consider how they will look on screen. It was found some fonts - like Verdana - tend to look better on a computer monitor. Other fonts are more suited to print. The investigator had to see if the font was visible on a computer screen or digital projector. The investigator also had to see if the font still looked good when the presentation was printed out.

Moving from slide to slide

To move to a previous slide, the investigator followed these steps:
1. By clicking the upper double-arrow button ▲ on the lower right corner of the PowerPoint window. The previous slide appeared.

To move to the next slide:

1. Clicked the lower double-arrow button ▼ on the lower right corner of the PowerPoint window.

**Switching to Outline View**

To switch to Outline View, the Outline View button in the lower left-hand corner of the PowerPoint window was clicked.

This is what the investigator saw in Outline View:

When the investigator moved to Outline View, PowerPoint automatically displayed an Outline Toolbar on the left side of the window. It contained many useful tools for working in this view.
Steps followed by the investigator for adding a slide to the outline

The investigator added a new slide in Outline View the same way as done in the Slide View.
2. In the New Slide dialog box, clicked a slide layout, then clicked OK. A new slide icon appeared in the outline.

To add a new slide right after a slide title:
1. The investigator placed the cursor at the end of a slide title.
2. Pressed the Enter key. A new slide icon appeared in the outline.

Steps used by the Investigator for adding text to the outline

If the investigator wanted to add text to a slide that was created previously, she needed to click an insertion point in the outline and start typing.
If the investigator wanted to add text to a new slide that was created in Outline View, following steps needed to be perused:
1. Typed a title beside the slide icon.
2. After the slide title needed to press the Enter key. PowerPoint added a new slide.
3. Clicked the button on the outline toolbar to convert the new slide to a text object.

4. Now the investigator could type the text.

1. PowerPoint in the Classroom
2. PowerPoint presentations are:
   - fun to make

5. To add another bullet point, pressed Enter. With the exception of the title slide, any text added by the investigator was formatted as a bullet point.

The investigator could get the bird’s eye view of the MMLP by moving around in Outline View
In Outline View, the investigator could see all the text that appeared on the slides and could see all the outline titles in one shot. This option could also be used to print an outline of the presentation or for check the logical flow of your slide titles without the distraction of extra text.
To collapse all the slides in your outline, the investigator had to take these steps:
1. On the Outline Toolbar, clicked the Collapse All button. The slide text for all the slides disappeared.

To expand all of the slide titles again:
1. Clicked the Expand All button on the Outline toolbar. The text for all the slides appeared again.
Jumping from one slide to the next

To move from one slide to another in Outline View, the investigator could click anywhere on the slide that she wanted to move to.

The investigator kept on saving the Presentation at every step

While working on a presentation, it’s a good idea to save your work often. Otherwise, there was risk of losing the work at any stage due to power failure or any other reason. The investigator kept on saving the work at every stage. The following steps were used to save the MMLPs to the hard drive. When the investigator was saving for the first time the Save AS command was used.

1) Clicked the File menu, and then clicked Save As. The Save As dialog box appeared.

2) In the File name box, the investigator typed a name the MMLP (presentation).

3) Clicked Save.

The presentation is now saved to the hard drive.

Once the investigator saved the presentation for the first time, periodically could save it by clicking the File menu, then clicking Save. Or, clicked the Save button on the Standard toolbar.
The AutoContent Wizard was used by the investigator for Creating MMLPs.
First the investigator launched PowerPoint then clicked the AutoContent Wizard option button in the PowerPoint dialog box to start a presentation.
Following were the steps used to start the AutoContent Wizard:
1. Clicked the File menu, then click New. The New Presentation dialog box appeared.
2. In the New Presentation dialog box, clicked the Presentations tab.
3. In the Presentations list, clicked the AutoContent Wizard, and then clicked OK. The wizard got started.

The investigator Worked with the AutoContent Wizard
The AutoContent Wizard guided the investigator through some simple steps.
1. The investigator read the information on the start screen, and then clicked Next.
2. In the next dialog box, selected the type of presentation the investigator wanted to give, and then clicked Next to advance to the next dialog box.
3. Continued entering options until reached the Finish step.

The AutoContent Wizard displayed the MMLP in Outline View. The outline is made up of sample slides, each of which had a suggestion for the type of information that was to be entered in the slide. So the investigator customized the information in the slides in either Outline View or Slide View.

**Template used for developing MMLPs**

A template, also called a presentation design, it helped the investigator to create a presentation without worrying about design elements. The template defines the color, background, and font of the slides. PowerPoint has many templates, which the investigator could preview and select in the New Presentation dialog box. PowerPoint also allowed the investigator to customize the templates. For instance, the investigator could change the background color or typeface of a template. Investigator has used different templates for developing Multimedia Learning Package.

**Creating a MMLP using templates**

After the investigator had just launched PowerPoint, the Template option button was clicked in the PowerPoint dialog box to start a new presentation.
When the investigator was already working in PowerPoint, following steps were taken:

1. Clicked the File menu, and then clicked New. The New Presentation dialog box appeared.
2. Clicked the Presentation Designs tab, and then clicked an appropriate template. The design appeared in the preview box.
3. Clicked OK. The New Presentation dialog box closed.

Changing background colour of the slides in the MMLPs

In PowerPoint it's easy to change the background colour of the slide, the investigator was working on. If the investigator wanted to change the colour of the slide to light blue, here’s what she needed to do:

1. Clicked the Format menu, and then clicked Background. The Background dialog box appeared.
2. In the Background fill section, clicked the arrow on the list box to open it.
3. Clicked More colors to open the Colors dialog box.
4. In the Colors section, clicked a light shade of blue.
5. Clicked OK to close the Colors dialog box.
6. In the Background dialog box, clicked the Preview button to see a preview of the slide color.
7. If the investigator liked what she saw, clicked the Apply button. The background colour of the slide was now light blue.

For Changing background pattern the investigator followed these steps:

1. Clicked the Format menu, and then clicked Background. The Background dialog box appeared.
2. Clicked the Background Fill list box, and then clicked Fill Effects. The Fill Effects dialog box appeared.

4) Clicked the Pattern tab, and then clicked the pattern, the investigator wanted in the Pattern box. A preview of the pattern appeared in the Sample box.

4. If the investigator wanted to change the background and foreground colors of the pattern, she had to select them from the Background and Foreground drop down lists.
5. Clicked OK to close the Fill Effects dialog box.
6. In the Background dialog box, clicked the Apply button.

**The investigator had a wide range of colours available to choose from**

When it came to text colours and background colours and patterns, the investigator had a dizzying array of choices. While it was possible to go crazy with them, it was best to stay on the more conservative side and create something the student's should actually read.

It was good to choose a high contrast between text and background colours. For example, black text and white background is most legible. Other good combos included white text on a dark blue or purple background or dark blue text on a yellow background.

The investigator wanted to use backgrounds and also used patterned ones. For MMLPs – Growth and Development, Learning and Personality, the investigator designed the templates using appropriate pictures. The investigator decided to keep the background pattern as subtle as possible. Very jazzy patterns were avoided by the investigator since they could have made it very difficult to read text and could make the pre service teachers confused.

**Spellings Checking by using PowerPoint spelling Checker.**

It's a good idea to check the spelling in our presentation before the audience sees it. The investigator used the PowerPoint's spelling checker to check the presentation. When the spelling checker was activated, it checked the spelling in all the slides.

1. On the Standard toolbar, clicked the Spelling button.

2. If a spelling error was detected a Spelling dialog box appeared.

3. The Spelling Checker suggested an alternative spelling in the Change To box. An additional list of suggestions also appeared below the box.
4. If the investigator wanted to continue without changing the spelling, clicked Ignore.

5. If the investigator wanted to change the spelling, entered one of the suggested alternatives in the Change to box, then clicked Change.

After the investigator had made the selection in the spelling dialog box, the spelling checker continued checking the remaining slides. When it had checked all the slides in the presentation, a message box appeared telling that the spell check was complete.

The investigator could even turn the automatic spelling checker off

As the investigator typed, a red wavy line appeared under misspelled words. If the investigator wanted to correct the spelling immediately, then with a right-click of the mouse on the word, and a menu appeared suggesting spelling alternatives.

If the investigator didn't want to see wavy red lines under misspelled words as they were typed, the automatic spelling checker could be turned off.

1. Clicked the Tools menu, and then clicked Options. The Options dialog box appeared.

2. Clicked the Spelling tab.
3. Under Check spelling as the investigator typed, clicked the Spelling check box to deselect it. The check mark disappeared.

4. Clicked OK to close the Options dialog box. The automatic spelling checker got deactivated.

Even when the automatic spelling checker was turned off, the main spelling checker still worked. So the investigator could check the spelling in the presentation at any time by clicking the Spelling button on the Standard toolbar.

The investigator had to decide about going for spell check or not to spell check.

Spell Check should be done or not?

Using the spell checker was a good way to maximize the use of time - the most precious of resources. It was a pretty nice and comfortable to just sit back as the computer scanned the document. The downside was that the investigator might have used a wrong word - spelled correctly - and computer couldn’t point out such errors. The advantage of not using spell check was that it forced the investigator to be more careful about the spelling. So the spell checker was avoided by the investigator since it looked more like a crutch that could have left many words wrongly placed and spelled.

Adding a new text box

Sometimes, the investigator has to add text to a slide without using a built-in text box. For example, to type a label for a drawing, the investigator added text box using following steps:

1. On the drawing toolbar, clicked the Text Box button. The pointer changed to a cross.
2. Clicked on the slide where the investigator wanted to place the text. A small text box appeared.
3. Typed a word in the text box. As the investigator typed, the box expanded to fit the text.

4. After the investigator finished typing, clicked outside the text box. The border around the box disappeared.

**Moving a text box**

The investigator followed the following steps to move a text box:
1. Clicked the text box the investigator wanted to move. A thick gray border appeared around the text box.
2. Placed the pointer on the border. The pointer was changed into a four-headed arrow.
3. Hold down the mouse button and dragged the box to the new location.
4. Released the mouse button.

**Adding colour to a text box**
1. Clicked the text box to select it.
2. On the drawing toolbar, clicked the arrow beside the Fill Color button, and then clicked the green colour box. The text box turned green.
Changing the font
The investigator used following steps to change the font.

1. Clicked the text box to select it.

2. Placed the pointer on the box's border, and clicked again. The insertion point disappeared, indicating that the entire text box was selected.

3. Clicked the Format menu, and then clicked Font. The Font dialog box appeared.

6. In the Font style list, clicked Bold; in the Size list, clicked 36; and in the Color list, clicked green.
5. Clicked OK to close the font dialog box.
All the text in the text box is now green, bolded, and a font size of 36.

Adding a shape
PowerPoint lets you add a variety of shapes to the slides of your presentation.
Adding a star shape to the slide, using the AutoShape tool on the drawing toolbar.
1. Clicked the AutoShapes button, point to Stars and Banners, and then click the 5-point star shape. The pointer was changed into a cross.
2. Clicked anywhere on the slide. A star of predefined size will be inserted.

- To make the shape larger (or smaller), drag a resizing handle. To resize the shape proportionally, hold down the SHIFT key as you drag.

**Adding color and texture to a shape**

Adding the colour yellow to the star.

1. Clicked the star shape to select it.
2. Clicked the arrow beside the Fill Color button, and then clicked More Fill Colors. A Colors dialog box appeared.

3. Clicked the Standard tab, then under Colors, clicked a shade of yellow.
4. Clicked OK to close the Colors dialog box.

Next, adding some texture to the shape:

1. Clicked the star to select it.
2. Clicked the arrow beside the Fill Color button, and then clicked Fill Effects. The Fill Effects dialog box appeared.
3. Clicked the Texture tab.
4. Clicked on a texture, and then clicked OK.
Adding clip art

The investigator followed the following steps to add a cartoon image to the slide:

1. On the Standard Toolbar, clicked the Insert Clip Art button.

2. The Microsoft Clip gallery dialog box appeared.

3. Clicked the Clip Art tab.

4. In the Categories list, clicked Cartoons. PowerPoint displays clip art from the Cartoons category.

5. Clicked an image to select it.

6. Clicked the Insert button. The cartoon image was inserted on the slide.
Resizing clip art

Like text boxes and shapes, it was easy to change the size of a clip art image. Here's how:

1. Clicked the cartoon image to select it.
2. Place the pointer on a resizing handle. The pointer changed into a two-headed arrow.

3. While holding down the mouse button, dragged the mouse outwards to enlarge the image. If the investigator dragged the mouse inwards, the size of the image was reduced.
4. When the image was the size the investigator wanted, released the mouse button.

Adding a Transition

A transition is a special effect used to introduce a slide during a slide show. The following steps were used by the investigator to add a transition to a slide.

1. In Slide Sorter View, clicked the slide the investigator wanted to add the transition to.
2. Clicked the Slide Show menu, and then clicked Slide Transition. A Slide Transition dialog box appeared.

3. In the Effect list box, clicked Checkerboard Across.
4. Clicked the Medium option button to select a speed for the transition.
5. Clicked the Apply button. A slide transition icon appeared under the slide's left corner, indicating that the transition has been applied.

To apply the same transition to all the slides in the presentation, clicked the Apply to All button in the Slide Transition dialog box.

**Timing a transition**

To run slide show automatically, timing was added to the slides.

Here's how the investigator added timing to the slides:

1. Selected the slide to add timing to by clicking it.
2. In Slide Sorter View, clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition dialog box appeared.
3. Under Advance, clicked the check box next to Automatically After.
4. In the seconds box, typed the number of seconds to remain on the slide. For example, 5 seconds.
5. Clicked the Apply button.

Adding Sound

There were different methods to add sound in PowerPoint. The investigator wanted to use her own voice and also wanted to add background music to it. So she chose to record her voice using sound recorder and after mixing it with background music, added it to the PowerPoint.

The following steps were taken by the investigator to record her voice:

1. Launching Sound Recorder

- In Windows XP, navigated to Start > All Programs > Accessories > Entertainment > Sound Recorder.
- When the Sound Recorder popped on-screen, the investigator noticed that it looks a bit like a tape recorder front panel.
- In the center of the window was a flat, green line. As the sound played or records, this green line oscillates to visually represent the sound.
- To the left was the Position indicator, represented in hundredths of a second.
- To the right was the Length indicator, showing the total duration of the sound file.
- Below these features was a Slide Bar indicator that shows where the sound file was playing, relative to its overall length.
- Finally, located below the Slide Bar, the investigator saw the universal symbols (from left to right) for Rewind ‹‹, Fast Forward ‹›, Play ‖, Stop ■, and Record •.
2. Setting the Microphone Record Level
Before beginning recording, the investigator checked the microphone settings for a proper volume level.

1. After starting Sound Recorder, clicked on Edit Audio Properties.
2. In the Audio Properties dialogue box, under the Sound recording section, checked to see that the sound card was the Default device.
3. Below the Default device, clicked on Volume.

4. In the Recording Control dialogue box, the investigator selected the microphone as the recording source, and turned its volume up full.

5. Closed the dialogue box and returned to the Audio Properties box.
6. Clicked OK.
3. Recording a Sound

To record and play audio, the investigator needed a sound card, a microphone, and speakers or headphones. To record the voice, the investigator hooked the microphone into the audio-in jack on the computer's sound card.

1. On the **File** menu, clicked **New**.
2. To begin recording, clicked • and speak into the microphone.
3. To stop recording, clicked ■.
4. To continue recording, clicked • and speak into the microphone again.
5. When finished, clicked ■ to stop recording.
6. On the **File** menu, clicked **Save As**. Typed a new name for the file, selected the location to save the file, and Clicked the **Save** button.

4. Adding Effects to a sound file

The effect tools are located in Sound Recorder’s **Effects** menu.

The effects in Sound Recorder are:

![Effect Tools](image)

**Increase Volume**

This increases the volume by 25%. (However, investigator can select this option twice for a 50% increase, three times for a 75% increase, and so on.)

**Decrease Volume**

This decreases the volume by 25%.

**Increase Speed**

This doubles the rate of a sound’s playback.

**Decrease Speed**

This slows the rate of a sound’s playback by 50%.

**Add Echo**

This adds an audio reverb.
**Reverse**  
This reverses the sound so it can be played backward.

**Adding sound to animations**  
The investigator has added sound to MMLPs by using following steps:  
1. In Slide View, selected the animated object that investigator want to add the sound effect to by clicking it.  
2. Clicked the Slide Show menu, and then clicked Custom Animation.

![Slide Show options](image)

3. Under Entry animation and sound, selected a sound effect from the drop-down list.

![Entry animation and sound options](image)

4. To preview the sound effect, clicked the Preview Button.  
5. Clicked OK to add the sound to the animation. The sound was added to the animated object.

**Adding sound to transitions**  
The investigator has added the sound files in the Presentation using following steps:  
1. In Slide Sorter View, clicked the slide with the transition the investigator were adding sound to.  
2. Clicked the Slide Show menu, and then clicked Slide Transition. The Slide Transition dialog box appeared.
3. Selected a sound effect from the Sound drop-down list, then clicked Apply. The sound was added to the transition.

To continue playing until the next sound in the presentation, clicked the check box next to 'Loop until next sound'.

**Adding a video clip**

The investigator has also added video clips to the presentation. Following are the steps used to add video clip in the presentation.

1. Clicked the Insert menu, point to Movies and Sounds, and then clicked Movie from File. The Insert Movie dialog box appeared.

2. In the Look in box, located the drive and folder where the investigator has saved the video clip.

3. Selected the video clip file from the file list, and then clicked OK. A video screen icon is added to the slide.
4.3.2.5 Story Boarding

The researcher had collected the information, organized it sequentially. Now it was further enriched with various multimedia elements to make it more effective. At this stage the researcher decided about the placing of various elements in various steps or parts of MMLP. It was more about the arrangement of the content for the presentation purpose. The researcher decided about the background music input, fading in and fading out of the text and images on the slides of MMLPs. A smooth transition was also worked out at this stage.
Growth and Development
Learning
Motivation
Personality
Basic Statistics

Figure 4.10 Listing of MMLPs
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define growth and development.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the differences between growth and development.</td>
</tr>
<tr>
<td>3</td>
<td>Understand and explain the principles of growth and development.</td>
</tr>
<tr>
<td>4</td>
<td>List out the educational implications of principle of growth and development</td>
</tr>
<tr>
<td>5</td>
<td>Describe the role of heredity and environment in development.</td>
</tr>
<tr>
<td>6</td>
<td>List out the stages of human development.</td>
</tr>
<tr>
<td>7</td>
<td>List and describe the Piaget’s stages of cognitive development.</td>
</tr>
<tr>
<td>8</td>
<td>List and describe the Erikson theory of development.</td>
</tr>
<tr>
<td>9</td>
<td>List and describe the Freud’s psychosexual development.</td>
</tr>
<tr>
<td>10</td>
<td>Define adolescence.</td>
</tr>
<tr>
<td>11</td>
<td>Understand the characteristics and aspects of adolescent development.</td>
</tr>
<tr>
<td>12</td>
<td>Understand the needs and concerns of adolescent.</td>
</tr>
<tr>
<td>13</td>
<td>List out the national policies on adolescent health.</td>
</tr>
<tr>
<td>14</td>
<td>List out the ways by which parents and teachers can help adolescent.</td>
</tr>
</tbody>
</table>
Figure 4.11 Story Board of Multimedia Learning Package (Growth and Development)
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define learning.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the characteristics of learning.</td>
</tr>
<tr>
<td>3</td>
<td>List out the different factors affecting learning.</td>
</tr>
<tr>
<td>4</td>
<td>Understand and explain the trial and error theory of learning.</td>
</tr>
<tr>
<td>5</td>
<td>List out the educational implications and limitations of trial and error theory of learning.</td>
</tr>
<tr>
<td>6</td>
<td>Understand and explain the insight theory of learning and Gestalt theory of learning.</td>
</tr>
<tr>
<td>7</td>
<td>List out the educational implications and limitations of insight theory of learning.</td>
</tr>
<tr>
<td>8</td>
<td>List out the difference between learning by trail and error and learning by insight.</td>
</tr>
<tr>
<td>9</td>
<td>Define classical conditioning, unconditioned stimulus, unconditioned response, conditioned stimulus, and conditioned response.</td>
</tr>
<tr>
<td>10</td>
<td>Explain classical conditioning by Pavlov and John Watson.</td>
</tr>
<tr>
<td>11</td>
<td>Describe the processes of extinction, reconditioning, and spontaneous recovery. Give an example of each.</td>
</tr>
<tr>
<td>12</td>
<td>Define and give an example of stimulus generalisation and stimulus discrimination.</td>
</tr>
<tr>
<td>13</td>
<td>List out the educational implications of classical conditioning.</td>
</tr>
<tr>
<td>14</td>
<td>Define operant conditioning.</td>
</tr>
<tr>
<td>15</td>
<td>Understand the Skinner experiment and operations in operant conditioning.</td>
</tr>
<tr>
<td>16</td>
<td>Understand the types of reinforcers.</td>
</tr>
<tr>
<td>17</td>
<td>Define continuous and partial reinforcement schedules. Compare and contrast the fixed-ratio, variable-ratio, fixed-interval, and variable-interval reinforcement schedules.</td>
</tr>
<tr>
<td>18</td>
<td>List out the educational implications of operant conditioning.</td>
</tr>
<tr>
<td>19</td>
<td>Understand the difference between classical conditioning and operant conditioning.</td>
</tr>
</tbody>
</table>
Figure 4.12 Story Board of Multimedia Learning Package (Learning)
Table 4.14
Learning Objectives
Topic: Motivation

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define motivation.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the characteristics of motivation.</td>
</tr>
<tr>
<td>3</td>
<td>Describe the sources of motivation.</td>
</tr>
<tr>
<td>4</td>
<td>Define need, drive, incentive and motives.</td>
</tr>
<tr>
<td>5</td>
<td>Understand the types of motivation.</td>
</tr>
<tr>
<td>6</td>
<td>Recall the relation between motivation and learning.</td>
</tr>
<tr>
<td>7</td>
<td>List out the factors affecting motivation in class.</td>
</tr>
<tr>
<td>8</td>
<td>Describe Maslow's hierarchy of needs. Give examples of each kind of need.</td>
</tr>
<tr>
<td>9</td>
<td>List out the educational implications of Maslow's hierarchy of needs.</td>
</tr>
<tr>
<td>10</td>
<td>Recall the ways of motivating students.</td>
</tr>
<tr>
<td>11</td>
<td>Describe various needs of students and techniques to fulfill those needs.</td>
</tr>
<tr>
<td>12</td>
<td>List out the ways to create student motivation in the classroom.</td>
</tr>
</tbody>
</table>
Figure 4.13 Story Board of Multimedia Learning Package (Motivation)
### Table 4.15
#### Learning Objectives

**Topic: Personality**

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define personality.</td>
</tr>
<tr>
<td>2</td>
<td>Understand the dimensions, traits or aspects of personality.</td>
</tr>
<tr>
<td>3</td>
<td>List out the characteristics of personality.</td>
</tr>
<tr>
<td>4</td>
<td>Explain the integration of personality.</td>
</tr>
<tr>
<td>5</td>
<td>Recall the factors affecting personality.</td>
</tr>
<tr>
<td>6</td>
<td>Understand and explain the type theories of personality by Hippocrates, Kretschmer, Sheldon and Jung.</td>
</tr>
<tr>
<td>7</td>
<td>Understand and explain the trait theories of personality by Allport and Cattell.</td>
</tr>
<tr>
<td>8</td>
<td>Discuss Esyenck's type-cum-trait approach to personality.</td>
</tr>
<tr>
<td>9</td>
<td>Discuss the three levels of consciousness proposed by Freud.</td>
</tr>
<tr>
<td>10</td>
<td>Define and describe the nature and function of the id, ego, and superego.</td>
</tr>
<tr>
<td>11</td>
<td>Summarize Freud’s psychosexual stages of development.</td>
</tr>
<tr>
<td>12</td>
<td>Define archetypes.</td>
</tr>
<tr>
<td>13</td>
<td>Discuss Rogers’s and Maslow’s humanistic approach to personality.</td>
</tr>
<tr>
<td>14</td>
<td>List out the different methods of personality assessment.</td>
</tr>
<tr>
<td>15</td>
<td>Explain the different subjective methods of personality assessment.</td>
</tr>
<tr>
<td>16</td>
<td>List out the limitations of subjective methods of personality assessment.</td>
</tr>
<tr>
<td>17</td>
<td>Explain the different objective methods of personality assessment.</td>
</tr>
<tr>
<td>18</td>
<td>List out the limitations of objective methods of personality assessment.</td>
</tr>
<tr>
<td>19</td>
<td>Define projective techniques.</td>
</tr>
<tr>
<td>20</td>
<td>Understand the characteristics of projective techniques.</td>
</tr>
<tr>
<td>21</td>
<td>List out the types of projective techniques.</td>
</tr>
<tr>
<td>22</td>
<td>Understand the Rorschach test, Thematic Apperception Test, Children Apperception Test, Word Association Test and Sentence Completion Test.</td>
</tr>
<tr>
<td>23</td>
<td>List out the limitations of projective techniques.</td>
</tr>
<tr>
<td>24</td>
<td>Define MMPI and MMPI – 2</td>
</tr>
</tbody>
</table>
Figure 4.14 Story Board of Multimedia Learning Package (Personality)
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Learning Objectives</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Define the statistics.</td>
</tr>
<tr>
<td>2</td>
<td>Describe the scales of measurement.</td>
</tr>
<tr>
<td>3</td>
<td>Compare and contrast the types of statistics as descriptive statistics and inferential statistics.</td>
</tr>
<tr>
<td>4</td>
<td>Define descriptive statistics.</td>
</tr>
<tr>
<td>5</td>
<td>Understand the frequency table.</td>
</tr>
<tr>
<td>6</td>
<td>Define the measures of central tendency. Compare and contrast the mean, median and mode.</td>
</tr>
<tr>
<td>7</td>
<td>List out the pros and cons of mean, median and mode.</td>
</tr>
<tr>
<td>8</td>
<td>Able to compute mean, median and mode for a given set of data.</td>
</tr>
<tr>
<td>9</td>
<td>Define variability.</td>
</tr>
<tr>
<td>10</td>
<td>Describe the range, quartiles and inter-quartile range.</td>
</tr>
<tr>
<td>11</td>
<td>Define and understand the standard deviation.</td>
</tr>
<tr>
<td>12</td>
<td>Able to compute range and standard deviation for a given set of data.</td>
</tr>
<tr>
<td>13</td>
<td>Define Normal Probability Curve (NPC).</td>
</tr>
<tr>
<td>14</td>
<td>Discuss the characteristics and applications of Normal Probability Curve.</td>
</tr>
<tr>
<td>15</td>
<td>Define correlation.</td>
</tr>
<tr>
<td>16</td>
<td>Understand the types of correlation.</td>
</tr>
</tbody>
</table>
Basic Statistics

Figure 4.15 Story Board of Multimedia Learning Package (Basic Statistics)
4.3.2.6 AUTHORING

In case of MMLPs the page based and time based authoring tools have been used where content is conceived as a sequence of pages or frames. So MMLPs can be visualized as a sequence of pages of frames which contain media elements embedded in them. Like every page of the book each frames continued many media elements like – test, video, audio and animation. The instructor could always manually visit the slides in any sequence.

---

**What is Statistics?**

- Statistics is the science of collecting, organizing, analyzing, presenting, interpreting and drawing conclusions from data.

Any values (observations or measurements) that have been collected.

---

**MEDIAN**

- The value that falls exactly in the midpoint of a ranked distribution.

<table>
<thead>
<tr>
<th>Median = 5</th>
<th>Median = 5</th>
</tr>
</thead>
</table>

- In an ordered array, the median is the "middle" number.
- If n or N is odd, the median is the middle number.
- If n or N is even, the median is the average of the two middle numbers.
- Not affected by extreme values.

(continued)

---

**Shape of a Distribution**

- Measures of shape:
  - Symmetric or skewed
  - See how mean compares to median, and possibly the mode.
  - Check histogram.

**Left-Skewed**
- Mean $< Median < Mode$

**Symmetric**
- Mean $= Median = Mode$

**Right-Skewed**
- Mode $< Median < Mean$

---

Figure 4.16 Page based Multimedia Authoring
Figure 4.17 Time Based Multimedia Authoring
4.3.2.7 DATA DELIVERY
The MMLPs were developed by the researcher and written on the DVDs and pen-drives and were presented by the researcher to the teacher educators. These MMLPs were also shown to Experimental Group of pre-service teachers.

Try-Out of the MMLPs
After development, the Multimedia Learning Package was tried out on a group of 50 pre-service teachers of B.Ed. to obtain their response regarding effectiveness of the lessons.

Validation of MMLPs
Validation (or testing) is a painstaking procedure but an essential part of the total quality assurance process. It is the study of the effectiveness of design prototypes, acknowledging any weaknesses encountered. The purpose of validation was to check to see if the program could meet its specified objectives. Realizing the objectives of the validation process required clear testing procedures to be devised. Responses of educators to the MMLPs and scores on the post-test indicated that they were instructionally sound. Changes were made when needed with respect to sequence, content, presentation and clarity in language. The valuable suggestions of 13 Educational Psychology and Educational Technology Experts were also incorporated and thereby ensuring content and construct validity. MMLPs were again reviewed and thus the final draft of MMLPs was accepted and presented to the experimental group in the study. List of experts is given in Appendix – J.

4.4 HOMEPAGE
A homepage was created by the investigator to supplement the multimedia learning package. Homepage is an HTML page with various links to other HTML pages. These HTML pages contain information to various topics related to MMLP. Following topics were included in the homepage:
1. Educational Psychology – it's meaning, nature and scope
2. What is Multimedia?
3. Learning Objectives
4. Multiple Choice Questions
CREATION OF HOMEPAGE

Homepage was created by using HTML (Hyper Text Markup Language). HTML is a computer language. Like other computer languages, it is used to create something. HTML has been designed to create one thing though, and that is web (HTML) pages. Following steps were used by the investigator to create homepage:

**Step-1**
Firstly, investigator created the text documents containing the text that she wanted to appear on homepage. She gave the documents a name ending in *html* or *htm* and saved the document as "Text Only."

1. Open Notepad, go to Start-->Programs-->Accessories-->Notepad
2. The page in homepage began and ends with the HTML tag.

3. Investigator added the head, title and body tags. Investigator gave title to the page and typed text in between the body tags.
4. Browsers read HTML without any spaces, but it's easier for the investigator to read the code if the lines were broken up, instead of running together like this:

5. Before saving it, investigator had set up a folder on the hard drive named Homepage, to house all of the HTML files; to keep them together. To save the file, investigator used the following steps:
   i) Go to File—>Save As
   ii) Find the Homepage folder
   iii) Change the "Save as type" to All Files
   iv) Name the file with the extension .html/.htm

**Step-2**
To view the home page in a browser, investigator:
   i) Open Explorer
   ii) Go to File—>Open and then clicked Browse
   iii) Find the homepage inside the folder on the disk and clicked Open.
Investigator opened up the HTML file in notepad as well. So when investigator typed HTML in Notepad, she can quickly view the results by going to the browser and hitting refresh.

**HTML Tags**

HTML is made up of a series of tags, which are similar to commands, telling the web browser what to do. These tags can be typed into any normal text editor such as Notepad, and when in the right order, form a web page. Writing HTML then is simply, writing tags. The basic skeleton for an HTML document looks like this:

```html
<html>
<head>
<title>Title of Page</title>
</head>
<body>
Text of page...
</body>
</html>
```

Notice that (1) each formatting tag appears between "less than" (<) and "greater than" (>) signs, and (2) the tags often appear in pairs, with the second tag in the pair beginning with a "slash" (/).

Here's a list of some of the basic formatting tags in HTML:

<table>
<thead>
<tr>
<th>Tags (not all have closing tags)</th>
<th>Purpose / Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;p&gt;</code> <code>&lt;p&gt;</code></td>
<td>Paragraph break</td>
</tr>
<tr>
<td><code>&lt;p align=&quot;center&quot;&gt;</code> <code>&lt;p&gt;</code></td>
<td>centering</td>
</tr>
<tr>
<td><code>&lt;br&gt;</code></td>
<td>Line break.</td>
</tr>
<tr>
<td>HTML Tag</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td><code>&lt;blockquote&gt;</code></td>
<td>Indents text</td>
</tr>
<tr>
<td><code>&lt;b&gt;</code></td>
<td>Bold</td>
</tr>
<tr>
<td><code>&lt;i&gt;</code></td>
<td>Italic</td>
</tr>
<tr>
<td><code>&lt;u&gt;</code></td>
<td>Underline</td>
</tr>
<tr>
<td><code>&lt;h1&gt;</code></td>
<td>Heading 1</td>
</tr>
<tr>
<td><code>&lt;h2&gt;</code></td>
<td>Heading 2</td>
</tr>
<tr>
<td><code>&lt;h3&gt;</code></td>
<td>Heading 3</td>
</tr>
<tr>
<td><code>&lt;h4&gt;</code></td>
<td>Heading 4</td>
</tr>
<tr>
<td><code>&lt;h5&gt;</code></td>
<td>Heading 5</td>
</tr>
<tr>
<td><code>&lt;h6&gt;</code></td>
<td>Heading 6</td>
</tr>
<tr>
<td><code>&lt;pre&gt;</code></td>
<td>Preformatted text</td>
</tr>
<tr>
<td><code>&lt;div&gt;</code></td>
<td>Division (used to apply a format to a larger section)</td>
</tr>
<tr>
<td><code>&amp;nbsp;</code></td>
<td>Non-breaking space</td>
</tr>
</tbody>
</table>

### Lists

#### Unordered List

```html
<ul>
  <li>apples</li>
  <li>pears</li>
  <li>oranges</li>
</ul>
```

- apples
- pears
- oranges

#### Ordered List

```html
<ol>
  <li>first</li>
</ol>
```
Adding Images to Homepage

To add images in the homepage, following image tag was used:

```
<img src="image.gif" />
```

The `img` stands for `image`. The `src` stands for `source`. The source of the image is the address of the image or the filename:

```
<img src="image.gif" />
```

The filename does not have to end with `.gif`; it can be a `.jpg` file as well. These are two of the most common image file extensions used on the Internet.

The image tag displayed the image on the page, aligned to the left, like this:
If the investigator wants to center the image on the page, she had to place the center tag around the image tag, like this:

```html
<center>
<img src="next.jpg" />
</center>
```

Use of center tag had placed the image in the center of the screen:

![Next](next.jpg)

Using HTML tags, investigator aligned all images in the homepage.

Homepage was used with MMLPs to give information about the various topics related to the MMLP. The concept of the Educational Psychology and Multimedia was given in the homepage for pre-service teachers, so that they should get fair idea about both the concept. Learning objectives and reference for further study of all the five topics used in MMLPs were also listed in the homepage. For the purpose of practice, objective and subjective questions were also included in the homepage. Thus, MMLPs along with the homepage make a complete multimedia package for the pre-service teachers.

### 4.5 SETTING UP MULTIMEDIA STUDIO

Before embarking on the journey of developing MMLP's the instructor thought of the approach to be adopted and laid out a plan. For setting up a Multimedia Studio it was necessary for the researcher to have an understanding of the following—

1. Knowledge and understanding of various medias - software and hardware
2. Listing and understanding of various mediums.

#### 4.5.1 HARDWARE AND SOFTWARE REQUIREMENTS

The researcher began with setting up and tuning up Multimedia Hardware in such a manner so that a well equipped multimedia studio could be set up. The researcher
studied and found that there were two distinct kinds of multimedia hardware available in the market:

1. Those with multimedia enabled motherboards- requiring little or no additional multimedia peripherals.
2. Those build with additional multimedia peripherals.

So the researcher could choose to buy a motherboard with audio input and output capabilities and thus save some cost on buying an external sound card. Or even could choose to buy a basic motherboard without multimedia capabilities and later on, add favorite sound card to it. The computer with Motherboard integrated multimedia was selected with a dedicated sound card with advanced capabilities to create next generation audio effects for MMLPs.

**Figure 4.18 Multimedia add-on cards (Hardware setup for MMLPs)**

AGP I Graphics accelerator cards were used as an interface between the computer and the monitor. While AGP cards merely handled the colour display and resolution, graphics accelerators helped in sophisticated graphics acceleration. So AGP cards helped in getting better visuals and performances in MMLPs.
The sound cards or the audio cards managed almost all possible kinds of audio including digital audio and mp3 etc. The researcher also used a pair of speakers or headphones for audio recordings. And of course, two good ears to actually hear the sounds as they come out of a sound card.

The CD Controller Cards were used to handle CD-ROM/CD-R Drives

Video Capture Boards were used by the researcher to capture video contents from VCRs and Handy cams into the computer, in digital video format.

VGA to PAL I NTSC Converter Card was used to convert PC to TV.

Multimedia software

The term multimedia software is very generic and conceptual in nature. Theoretically, any type of software performing multimedia function or other can be termed as multimedia software. It encompasses a wide variety of tools, applications, packages, device drivers and utilities- all related to multimedia, in one way or the other.

![Multimedia Software Tools](image)

**Figure 4.19 Multimedia Software Tools**

**Multimedia Software Tools** - The following multimedia software were required for MMLPs development-
Device Driver Software- meant for installing and configuring multimedia peripherals.

Media Players- meant for handling multimedia file formats

Media Conversion Tools- meant for encoding / decoding multimedia contents and for converting one file format to another.

Media Editing Tools- meant for creating/ editing multimedia data.

Multimedia Authoring Tools- meant for combining different kinds of media formats and deliver them as multimedia contents.

While developing MMLPs Multimedia Applications were created with the help of above mentioned Multimedia Software Tools and Packages.

**External multimedia equipments used by the researcher for developing Multimedia Learning Packages**

Apart from all those add-on cards that listed in the above section, some external multimedia equipment was used to carry out the tasks. Some of them were:

- Scanner
- Digital camera
- Laser Printer
- Microphone
- Multimedia Speaker
- Camcorder

**Figure 4.20 External multimedia equipments for developing MMLPs**

1. Scanner
2. Digital Camera
3. Colour laser Printer
4. Microphone
5. Multimedia Speaker
6. Digital Handy cam/ Camcorder

Similar to multimedia peripherals, not all of the above listed equipments were required for all the MMLPs. It all depended upon the nature of Multimedia Learning Package and activities involved.

How the right multimedia peripherals and equipments were chosen-

Given the myriad of brands and products available in the multimedia peripherals category, it was but a complex exercise to choose the best products among the lot and to identify those that provided professional services and offer good value for money.

A good starting point, before buying any piece of multimedia hardware, the researcher checked up IT magazines and websites and caught hold of reviews/comparisons about the product. The researcher studied some data in the periodicals that provided monthly research results and offered information on multimedia hardware and the best of the breeds available in all categories.

4.5.2 MULTIMEDIA FORMATS AND THEIR FUNCTIONALITY

The selection of the most common multimedia formats required a great care because when the researcher selected a format, also needed to time it judicially only then it could make the entire presentation could be made effective. There was no overlapping of any particular element since it could cause overdosing. Animation makes a presentation effective and moving images have the multiple uses, but a screen should not include permanently moving animation so not to distract the user from interpretative text. The various formats of multimedia were used by researcher independently or in combination with one another in the right proportions. The choice of the format largely depended upon the nature and objectives of the concept and the availability of resources, time budget, 2-D and 3-D animation facilities for the multimedia programmes. Furthermore, it may be noted that though Multimedia Package can be a powerful learning and teaching tool because it engages multiple
senses, but its success or failure largely depends on the teacher using it. Multimedia package create a better learning environment and the students actively participate in the class. So Multimedia Learning Package can prove an effective tool in the hands of teachers if, it is rightly used in the class.

4.6 OVERVIEW

It was envisaged that the use of three-fold self developed tools namely – Achievement Test, Opinionnaire and Multimedia Learning Package along with homepage would provide enough data to examine the effectiveness of multimedia in its minutest details and help suggest the measures of impact on the stipulated variables outlined for the study. All the tools whole-heartedly endorsed the effectiveness of MMLPs. The data thus collected was subjected to mean score analysis and ‘t’ value was computed to arrive at significant findings of the study.